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Copyright 

The NTI Backup NOW!® software and the contents of this associated User’s Guide are properties of 
NEWTECH INFOSYSTEMS, INC. (NTI) and are protected by copyright. Any reproduction either in 
whole or in part is strictly prohibited. For additional copies of the software or this documentation, 
please contact NTI. 

Software as well as many other types of works are protected by international copyright laws. 
Unauthorized copying of those works in any manner may violate the rights of the owner of the 
copyright in those works and may expose you to civil and criminal penalties. 

You may not use NTI Backup NOW!® software to violate the copyright rights of others. NTI does not 
authorize you to use the NTI Backup NOW!® software for the purpose of violating the copyright rights 
of others. 

Information in this document is subject to change without notice. 

Trademarks 

The NTI logo, NTI Backup NOW!®, NTI DVD-Maker®, and Dragon Burn® are registered trademarks 
of NewTech Infosystems, Inc. NTI DriveBackup!, NTI CD-MakerTM, NTI CD-Maker Elite, NTI CD-
Maker Pro, NTI CD-Maker 2000, NTI CD-Maker MM, NTI FileCD™, NTI CD-Copy Tools, NTI 
CDR Explorer, NTI JewelCase Maker are trademarks of NewTech Infosystems, Inc. Windows is a 
trademark of Microsoft Corporation. All other product names or trademarks are property of their 
respective owners. 

License 

Use of this software constitutes your acceptance of these terms and conditions and your agreement to 
abide by them. You, the original purchaser, are granted a non-transferable, non-exclusive personal 
license to use the software. You may neither transfer the software or otherwise make it available to 
anyone else, nor may you copy, modify, disassemble, decompile, reverse engineer, revise or enhance the 
software, electronically transfer, or lease the software or this user manual. 

You may terminate this agreement at any time by destroying the software. This agreement will Use of 
this Software constitutes your acceptance of these terms and conditions and also terminate if you fail to 
comply with the terms and conditions of this agreement. You agree upon such termination to destroy 
the software. 

Limited Warranty 

NTI warrants for a period of thirty (30) days from the date of delivery that, under normal use and 
without unauthorized modification, the program performs in substantial compliance with the User’s 
Guide and those set forth in NTI authorized advertising material; that under normal use, the magnetic 
or optical media upon which the software is distributed is substantially free from significant defects in 
materials and workmanship. Warranty claims must be made in writing during the Warranty Period and 
within seven (7) days of the observation of the defect, accompanied by evidence satisfactory to NTI. If 
NTI is unable to correct it within ninety (90) days of the date you report the defect, you may return the 
software and accompanying materials to the NTI distributor from where they were purchased (if not 
purchased directly from NTI) and shall be shipped by the returning party with freight and insurance 
paid. 

 



EXCEPT AS STATED ABOVE, THERE IS NO OTHER WARRANTY, EXPRESSED OR 
IMPLIED, REGARDING THE PRODUCT INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Limit Of NTI’s Liability 

NTI’s entire liability for damages to you or any other party for any cause whatsoever, whether in 
contract or in tort, including negligence, shall not exceed the price you paid for the unit of the software 
that caused the damages or that are the subject matter of, or are directly related to, the cause of action. 
In no event will NTI be liable for any damages caused by your failure to perform your obligations, or 
for any loss of data, profits, savings, or any other consequential and incidental damages, even if NTI has 
been advised of the possibility of damages, or for any claims by you based on any third-party claim. 

Changes 

With reasonable efforts have been made in the preparation of this documentation to assure its 
accuracy, NTI assumes no liability resulting from errors or omissions in this document, or from 
the use of the information contained herein. 
 
NOTICE 

NTI Backup NOW!® software is designed to assist you in reproducing material in which you own 
the copyright or have obtained permission to copy from the copyright owner.  

NTI does not authorize you to use the software for the purpose of violating the copyright rights 
of others. Violating the copyright rights of others may result in severe civil and criminal penalties, 
and may be prosecuted to the maximum extent possible under the law. 

NTI takes no responsibility for any illegal use of the product. If you are not sure about your 
rights, please consult your legal advisor before using NTI software. 
 
Termination 

Your failure to comply with the terms in this Agreement shall terminate your license and this 
Agreement.  
 
U.S. GOVERNMENT RESTRICTED RIGHTS.   
 
The Software and user documentation is provided with RESTRICTED RIGHTS AND 
LIMITED RIGHTS.  Use, duplication, or disclosure by the Government is subject to restrictions 
as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software 
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software--Restricted Rights at 48 CFR 52.227-19, as applicable. NewTech Infosystems, Inc., 5 
Mason Avenue, Suite 150, Irvine, CA 92618 U.S.A. 
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First Things First 
About This Guide 
This User’s Guide is unified, in that Windows 95/98/Me and Windows NT/2000/XP share common 
information.  In each section, and as required, notes have been included where there are particulars 
pertaining to Windows NT/2000/XP operation, performance, or use. 

About NTI Backup NOW!® Deluxe 
NTI Backup NOW!® is a powerful backup suite for use with your CD and DVD writers; local, 
networked and external hard disks; as well as many other backup devices such as Zip, Jaz, MO, and 
USB pen drives. It is a powerful, yet simple, program to effortlessly create scheduled backups of your 
crucial data, without requiring the hours of learning that other backup solutions usually entail. The NTI 
Backup NOW!® Deluxe suite includes NTI Backup NOW!®, NTI DriveBackup!™ and NTI Backup 
NOW! Scheduler. 

Backup NOW! handles the backup of your important files. Backup NOW!’s intuitive user interface 
allows you to instantly navigate your way around your computer to locate files easily. The familiar 
Windows interface makes backing up your valuable data easy. Featuring our EasySteps® interface, all 
operations are accomplished in very simple steps. Each step is clearly identified by Backup NOW!. 
Backing up or restoring your files is a simple three-step process. Step one – Tell Backup NOW! what 
files to backup/restore. Step two – Tell Backup NOW! where to backup or restore the data and Step 
three – Tell Backup NOW! how you want the data backed up or restored. 

The Backup NOW! Scheduler handles the scheduling and execution of your backup jobs. Schedule a 
job to run daily, weekly or monthly as your environment demands.  

DriveBackup! allows the backup/restore of your local hard drive through the use of an easy wizard 
interface. In addition, NTI DriveBackup!’s Emergency Recovery Wizard allows you to create a bootable 
Emergency Recovery Disc. This bootable CD/DVD can be used to recover your hard drive in cases of 
hardware failure or other critical hard disk problems.  

Now,  NTI Backup NOW!® Deluxe Version 3.0 adds DVD-RAM, DVD -R, DVD -RW, DVD+R, 
DVD+RW, local and network hard drives, Jaz, Zip and even USB pen drives to the list of supported 
output devices providing even more flexibility and power to meet your backup needs. 

NTI Backup NOW!® Deluxe offers the following advantages, making it the best and easiest solution for 
backing up your valuable data: 

• Takes advantage of 32-bit power of Windows 95/98/ME/NT/2000/XP and supports long 
file names. 

• Backup to CD-R/RW drives, DVD-R/-RW/+R/+RW/-RAM drives, USB pen drives, Jaz 
& Zip drives and local and network attached hard drives. 

• Supports data compression. 
• Supports both file level and image level (partition level) backup and restore. 
• Backup data from any drive source connected to your computer. 
• User selectable file level backup and restore. 
• Supports incremental and differential backups.  
• Backup or Restore across multiple discs. (Media Spanning) 
• Multi-drive Support on CD & DVD devices. (Drive Spanning) 
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• Run backup jobs instantly or schedule them for later execution. 
• Schedule backup jobs once or repetitively, on a daily, weekly or monthly basis. 
• Create bootable Emergency Recovery Disc. 
• Clone a partition or hard drive. 
• Append backup data or overwrite existing data on CD and DVD discs. 
• Exclude/Include specific file types from file level backups. 
• Full backup and restore reporting. 
• Time sensitive file replacements on restore operations. 
• Restore data to alternate locations. 

File Level and Drive Image Backup & Restore 
NTI provides a family of backup products to meet your file level and drive image backup needs.  These 
programs offer you the combination of choosing either file level or drive image (partition level) backup 
and restore operations. File level backups are handled by Backup NOW! while DriveBackup! takes care 
of all drive image backup operations. Your important data can be backed up to a local CD or DVD 
recorder or any attached device that provides drive letter access such as your hard drive, zip or jaz 
drives. Your backup data can be written to a single CD/DVD disc or span across several discs as 
necessary. Backup NOW! supports data compression to reduce the space requirements of a backup 
image.  
The following sections explain the capabilities and limitations of each backup method as well as when 
you need to use each one. 
Drive Image Backup 
Drive image backups create an exact copy of the drive/partition being backed up. NTI DriveBackup! 
bypasses the file system and copies all data directly from the hard drive. You can backup any drive that 
is installed on your computer system using drive image backups. A backup set can be saved on any CD 
or DVD recorder on your computer or any device that provides drive letter access installed or 
connected to your system, including network hard disk. 
Drive image backups are quick and easy using the Backup Wizard. You simply select the source drive, 
backup format and the destination drive and away you go! At the click of a button, DriveBackup! 
creates an image of the selected source drive. 
Restoring a drive using the Restore Wizard is just as easy. It is important to remember however, that a 
drive image backup is a snapshot of the source drive at a particular moment in time. Restoring from this 
type of backup image is an all or nothing event. The destination drive will be restored exactly as it was 
when the backup image was created. All changes to that drive, made after the time that the backup 
image was created, will not be restored! 
Since drive image backups are copies of the actual disk partition or hard drive and work directly with the 
physical device, it is not possible to selectively restore specific files or folders to your system. You must 
use file level backups, found in a product like NTI Backup NOW!® when you need to replace specific 
files or folders. 
Note: 
³ Because DriveBackup! communicates directly with the hardware layer, you must have 

Administrator Rights to install or run NTI DriveBackup! on machines running Windows 
NT/2000/XP. 
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File Level Backup 
These File level backups are the most flexible way of backing up your important data to a locally 
installed CD/DVD or other device providing drive letter access like a local hard drive. You can 
selectively backup and restore files, exclude specific file types such as hidden or system files and backup 
and restore the Windows Registry file using the file level backups. 

Source files can be located on any storage device installed on or attached to your computer system. File 
level backup jobs can be executed now or scheduled to run later or even on a periodic basis using the 
Backup NOW! Scheduler. The job files themselves can also be saved for later use or modification. 
Incremental and differential backups are fully supported using Backup NOW!’s file level backup. 
Note: 
³ You must have Administrator Rights to install NTI Backup NOW! on machines running 

Windows NT/2000/XP. You must be a member of the Administrators’ or the Backup 
Operator’s groups to run Backup NOW!. 

Which method of backup do I use? 
As mentioned earlier, DriveBackup!’s drive image backups are all or nothing events, they bypass the file 
system, backups are from a single hard disk drive (or partition) that must be physically installed on your 
computer, they can be saved to any attached device providing drive letter access such as a hard disk or a 
CD or DVD recorder and they are executed instantly, not a backup job that can be scheduled for a later 
date. Backup NOW!’s file level backups are very flexible and can be executed now or schedule to run at 
a later time. Use the table below to determine which backup method to use for a given situation. 

Desired Action NTI 
DriveBackup!™ 

NTI 
Backup NOW!® 

Create an Emergency Recovery Disc?   

Backup your data to a disk file?   

Make a duplicate of your source drive or partition?   

Restore backed up data to an alternative location?    

Backup/Restore the Windows Registry file?   

Clone a partition?   

Backup or Restore specific files or folders?   

Incremental or Differential backups?   

Schedule the backup for a specific time or date?   

Execute backups automatically on a daily, weekly or monthly basis?   

Backup up and restore a network drive?   

Backup and restore data from multiple drives to a single backup 
image? 

  

Exclude specific file types from your backup?   

Backup network files from another computer?   

Restore a file only if the copy on the backup is newer?   
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System Requirements 
It is important that your system meet the above requirements. If you have questions, please contact 
NTI for further information. Please check the following system requirements before installing Backup 
NOW!. 

H A R D W A R E  R E Q U I R E M E N T S  

y IBM PC or compatibles Pentium 90 or higher  

y Minimum 32 MB Main Memory. (64MB Recommended) Windows NT and Windows 
2000 Operating Systems may require at least 64 MB of Main Memory. 

y Some features require an NTI-supported CD/DVD recorder. Please visit our web site at 
http://www.ntius.com/CertifiedCDRdrives.htm for the latest list of NTI-supported 
recorders. 

S O F T W A R E  R E Q U I R E M E N T S  

y Microsoft Windows 95/98/Me, 2000 Professional, XP or Windows NT 4.0 Workstation 
(Service Pack 6) 
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Installing Backup NOW!  
To install NTI Backup NOW!® you will need approximately 20 MB of free hard disk space. An 
automated SETUP program is provided to guide you through the installation. The default target 
directory (the directory where NTI Backup NOW! resides), is “C:\Program Files\NewTech 
Infosystems\NTI Backup NOW!”. The setup program will walk you through the installation process. 

ª To install Backup NOW!: 

1. Insert the Backup NOW! Installation CD into the appropriate drive.  

2. Windows displays an install screen automatically. If you do not see this screen then click 
Run from the Start button on the Taskbar and in the dialog box type: 

D:\install.exe 
Note: 
³ Where "D" is the drive letter of the CD-ROM drive which contains the 

NTI Backup NOW!® CD. The drive letter may be different depending on 
your system configuration. 

3. Click OK to execute the Setup program. 

4. On the Welcome panel, click on the Next button. 

5. Read the END-USER LICENSE AGREEMENT FOR NTI SOFTWARE and click 
the Yes button if you accept the terms of the license agreement and wish to continue 
with the installation of the Backup NOW! software.  

6. Enter your user information and the product serial number (if required) and click Next. 

7. Select the installation directory from the Choose Destination Location dialog and click 
the Next button. Click the Browse button to select a different installation directory if 
desired. 

8. Enter the Program Folder where the Backup NOW! icons will be added and click Next. 

9. NTI Backup NOW!® will now be installed in the target directory. Backup NOW! 
program group with the appropriate shortcuts will be added to the Start menu. 

10. You will be asked to restart your computer. The Setup Complete dialog will let you 
reboot now or later. It is recommended to select the "Yes, I want to restart my computer 
now." option and Click the Finish button and reboot your computer. 

Notes: 
³ NTI Backup NOW!® and NTI DriveBackup!™ must be installed separately from the 

Backup NOW! Deluxe Installation CD. 

³ You must have Administrator Rights to install NTI Backup NOW!® or NTI 
DriveBackup! on machines running Windows NT/2000/XP. 
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Removing Backup NOW!  
You can remove the Backup NOW! software from your system from the Windows Add/Remove 
Programs utility. 

ª To uninstall the Backup NOW!  software: 

1. Run the Control Panel application from the Start -> Settings menu. 

2. Double-click  the Add/Remove Programs icon. 
3. From the Install/Uninstall Tab, select NTI Backup NOW!® from the list of programs 

installed on your computer. 
4. Click Add/Remove… 
5. Click Yes to confirm the removal operation. 

NTI Web Resources 
NTI is committed to your success! We hope to make your experience with Backup NOW! the best 
possible by making available news and information, product updates and upgrades, Frequently Asked 
Questions and our Technical Support from the Internet. Our web site is at www.ntius.com. 

Company or Product News and Information 
Find out the latest about NTI what we are doing at www.ntius.com/corporate/inthenews.htm or 
any of our world-class products at www.ntius.com/products/index.htm. Learn about the latest 
features or supported drives for Backup NOW! You can even download a trial version of any of our 
products directly from our web site giving you the easiest way to give our software a test drive before 
you buy. 

Frequently Asked Questions (FAQs) 
You can browse the latest information and commonly asked questions about Backup NOW! from our 
web site at www.ntius.com/faq.htm. Find out what questions other Backup NOW! users had about 
it. Get quick answers to the most commonly asked questions. 

Updating your Backup NOW! Software 
From time to time, we release product updates and upgrades from our web site. Product updates 
generally contain patches and other corrections to the Backup NOW! software and are available for 
registered users to download for free. Upgrades involve major product enhancements along with 
patches to reported problems. They will also be available for download but may involve a nominal fee.  

Updates can be installed by executing the downloaded file. All updated files and patches will be applied 
to your Backup NOW! software automatically! It is highly recommended that you download and install 
any updates prior to contacting our Technical Support Department. 

Visit our web site at www.ntius.com/download/index.cfm for the latest updates for all NTI 
products! 

Updating the Supported Drive Database 
We frequently add support to new drives to our drive support database. You can use our Live Update 
feature to download and automatically install the latest drive support database on your system. Click the 
Live Update item on the Tools Menu to use Live Update to download the latest database from our 
servers.  

Note: 
³ You must be online to use the Live Update feature. 
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Contacting Technical Support 
Many different types of on-line help are available with NTI Backup NOW!® within the specified 
applications. You can browse through the NTI Backup NOW!® Help file to become familiar with all 
the features available within that application. 

If you still experience problems using NTI Backup NOW!® that this documentation cannot solve, 
please check our web site at www.ntius.com/support/index.cfm for support. Help and information 
on the latest updates as well as an NTI Technical Forum on Frequently Asked Questions (FAQs) can 
be found on our web site at www.ntius.com/support/faq. 

Notes: 
³ If your NTI Backup NOW!® software came with your computer or CD Recorder, you will 

usually need to contact the support group of the provider of our software for support and 
updates for your software. You may visit our support site for general information and answers to 
FAQ's at your convenience. In most cases, our support team will be unable to assist you in this 
circumstance. We are sorry for any inconvenience or delays you may encounter. 

³ You must be a registered user to get support for our software. You will be asked to register your 
NTI software if you have not already done so. 

 
THANK YOU FOR YOUR COOPERATION! 
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Getting Started 

In this Chapter, we will show you how to backup, restore and compare your data with Backup NOW! 
using File Level backups. We will also show you how to create, save, edit, schedule and execute a 
backup job with Backup NOW!. Disk image backups using NTI DriveBackup! are explained at the end 
of this chapter. 

Getting familiar with Backup NOW! 

 

File 
Information 

Pane

Resource 
Tree Pane 

The first thing that you will notice about Backup NOW! is how it automatically customizes itself based 
on the operation you wish to perform. You can select from the Backup, Restore and Compare 
operations with the click of a button from the main toolbar. Backup NOW! does the rest.  
EasySteps® Interface 
Backup NOW!’s intuitive EasySteps® interface guides you through the backup, restore and compare 
process. Step one — Defines the data to be used or “What” data to backup, restore or compare. Step 
two — Defines the target destination or “Where” to backup, restore or compare the source data. Step 
three — tells Backup NOW! “How” to backup or restore the selected source data. Backup NOW! splits 
these into separate steps for ease of use. As you can see above, it is just a simple click of a button and 
you are on the next step of the process. 

Selecting files in Backup NOW! 
Backup NOW! uses a Window's Explorer style view when you need to select specific files or folders for 
any step of the selected operation. The selection view is split vertically into two panes. The left pane, 
Resource Tree Pane, displays the system resource tree. The right pane, File Information Pane, displays 
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detailed information about items selected from the system resource tree. Branches or nodes on the tree 
can be expanded or collapsed by clicking on the + or - to the left of the item or by double clicking on 
the item itself. The two panes may be resized horizontally by dragging the splitter bar between them. 
Dragging the splitter bar to the left will display more of the file information pane while reducing the 
visible portion of the resource tree pane. 

The file information pane has four columns that display the file/folder name, its size, the file type and 
the last modified date. The files may be sorted on any one of these columns by clicking on the column 
header. By default, files are sorted alphabetically (ascending) by name. Click the Name column heading 
to sort them in descending order by name. Items listed in the file information pane may include a small 
checkbox to the left of their name indicating that they can be selected within Backup NOW! Simply 
click the box to include that item and all items below it in the file structure in the current operation. For 
example, if you check the box to the left of the C: drive icon, all files and folders on your C drive will be 
selected automatically. If you expand the C drive from the resource tree and then check the box to the 
left of the Autoexec.bat file then only the Autoexec.bat file is selected for the current backup, restore or 
compare operation. 

ª To Select a file/folder: 

1. Navigate the resource tree to locate the desired file, folder or drive. 
2. Check on the box to the left of the desired item. 

ª To Deselect a file/folder: 

1. Navigate the resource tree to locate the desired file, folder or drive. 
2. Uncheck on the box to the left of the desired item. 

Using My Catalog 
Backup NOW! logs information about every backup executed in to a file called My Catalog. All restore 
and compare operations allow you to select from My Catalog or the actual backup files stored on CD-
ROM discs. The advantage of using My Catalog is that you can search for specific files from all catalogs 
on your system. You won’t have to swap CDs in and out to find the right file. Catalogs are saved in the 
Catalog folder in the Backup NOW! directory. Catalog files require additional disk space and over time, 
it can add up. You can view catalog entries from My Catalog using the File Catalog dialog box. 

ª To remove one or more catalog entries from My Catalog: 

1. In either Restore or Compare mode, select My Catalog in the From combo box. 
2. Select one or more of the catalog entries by checking the box to the left of their name. 
3. Click Remove to delete the selected catalog entries. 
4. Click Close. 

ª To load the resource tree from My Catalog: 

1. In either Restore or Compare mode, select My Catalog in the From combo box. 
2. Select one or more of the catalog entries by checking the box to the left of their name. 
3. Click Load. Backup NOW! loads the Resource Tree Pane with the selected catalog 

entries. 
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Creating a Backup Job 
File level backups are defined as a job to the Backup NOW! program. You select the backup operation 
by clicking the backup icon on the main toolbar. Backup jobs can be saved for later use and editing, 
scheduled for later execution by the Backup NOW! Scheduler or run directly from Backup NOW! 

ª To create a backup job: 

ª Step 1:   “What to backup”  

1. Click the Step 1 button on the left-hand side of the main window. 

2. Select the folders or files you wish to backup. (See Selecting Files in Backup 
NOW! in this chapter for additional information.) 

ª Step 2:  “Where to backup”  

1. Click the Step 2 button to select the destination of the backup file. 

2. Select the drive where the backup file will be saved. 

3. Change the filename of the corresponding backup file (XXX.NBF) if desired. 
Note: 
³ Backup NOW! will append a date and time stamp to the name information 

entered in this step. This date and time stamp will be updated automatically 
each time the job us executed. 

ª Step 3:  “How to backup”  

1. Click the Step 3 button to select the type of backup you wish to perform. 

2. Select from All selected files or New and changed files only.  

3. If you selected New and changed files only, you have to select from either 
Differential or Incremental options. You may click the Options button for 
advanced features.  

Note: 
³ See Chapter 4: Backup Options, or Backup Options: Type Tab for 

explanations of the terms. 

Once the backup job has been fully defined, you can save it by clicking on the Save button on the 
toolbar. Remember to set a password on the Password tab of the backup options should you wish to 
password-protect your backup file. Click the Start button to run the backup job now or the Schedule… 
to run it at another time using the Backup NOW! Scheduler.  
Note: 

³ If you attempt to run or schedule the job before saving you will be prompted to save the job 
before continuing. A backup job must be saved before it can be used with the Backup NOW! 
Scheduler. (See Chapter 3 – Backup NOW! Scheduler for information on scheduling a 
backup job for later execution. 
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Restoring Files from a Previous Backup 
File level restores can be run from a specific backup file or from My Catalog. You select the restore 
mode by clicking the restore icon on the main toolbar.  

ª To restore files from a previous backup: 

ª Step 1:  “What to restore”  

1. Click the Step 1 button on the left-hand side of the main window. 

2. Load the Resource Tree from either My Catalog or a specific backup file. (See 
Using My Catalog in this chapter for additional information.) 

3. Select the folders or files you wish to restore. 

Note: 
³ If you are not using the catalog option in Step 2 then you will be asked to select 

the backup set you wish to use. In the case that your backup set is spanned 
across multiple discs, you must insert the last disc of the backup set before 
Backup NOW! can load the resource tree. 

ª Step 2:  “Where to restore”  

1. Click the Step 2 button to select the destination or where you want to restore the 
backup files. 

2. Select the destination of the Restore, at its Original location or select an Alternate 
location. You can click the folder icon to the left of the alternate location textbox 
to browse your system for the desired restore location. 

ª Step 3:  “How to restore”  

1. Click the Step 3 button to select the type of restore you wish to perform. 

2. Select a restore option from the list. 

Note: 
³ See Chapter 4: Restore Options for additional information about each 

option. 

Once you have selected the files to be restored, simply click on the Start button to start the restore 
process. If the selected backup file has been password protected, you will be prompted for the password 
to this backup file. 

Note: 
³ The Resource Tree in Step 1 displays the location (disc number) of every file in the backup 

set. Please insert the correct disc before starting the restore process. In cases where you are 
restoring multiple files from multiple discs, Backup NOW! will prompt you for each disc as 
required. 
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Restoring files using Find Files 
You can search My Catalog or a backup image for a specific file using the Find Files. Are you missing a 
file that you know you had previously backed up? Locate the file in My Catalog and then restore it from 
the backup image. 

ª To locate and restore a file with Find Files: 

1. Load the Resource Tree from either My Catalog or a specific backup file. (See Using My 
Catalog in this chapter for additional information.) 

2. In Restore mode, select Find Files… item from the Edit Menu. 
3. Enter the name of the file you want to search in the “Named:” edit box. 

Note: 

³ The find files feature supports standard wildcard searches such as *.doc to 
locate all Word documents in a backup or selected catalog. 

4. From the list of found files, select the files you wish to restore. 
5. Select the location of the restore, and set the restore options. 
6. Click the Start button to start the restore operation. 
Note: 

³ The Find Files dialog displays the location (disc number) of every file that meets 
your Find criteria. Please insert the correct disc before starting the restore process. 
In cases where you are restoring multiple files from multiple discs, Backup NOW! 
will prompt you for each disc as required. 

Comparing Backup Files 
You can compare original files to the backed up version of that file using the compare operation. File 
level compares can be run from a specific backup image or the catalog. You select the compare 
operation by clicking the compare icon on the main toolbar.  

ª To compare backup files: 

ª Step 1:  “What to compare” 

1. Click the Step 1 button on the left-hand side of the main window. 
2.  Load the Resource Tree from either My Catalog or a specific backup file. (See 

Using My Catalog in this chapter for additional information.) 
3. Select the folders or files you wish to compare. 

ª Step 2:  “Where to compare” 

1. Click the Step 2 button to select the destination or where the files are you want to 
compare with the backup files selected in Step 1. 

2. Select the destination of the Compare, at its original location or an alternate 
location.  

Once you have selected the files to be compared, simply click on the Start button to start the compare 
process. 
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Drive Image Backup and Restore 
NTI DriveBackup!™, Version 3.0, is now included with NTI Backup NOW!® Deluxe. It allows you to 
create a backup of a partition to one or more CD/DVD discs or other devices that provide drive letter 
access such as a hard drive. 

Note: 
³ On Windows NT, 2000 & XP,  you must be logged on as Administrator in order to perform 

a drive image backup and restore. 

Getting familiar with DriveBackup! 

 
The first thing that you will notice about DriveBackup! is its graphical wizard interface. You can run the 
Backup, Restore and Emergency Recovery wizards with the click of a button from the opening screen. 
Once launched, NTI DriveBackup!’s wizards will take you one step at a time through the desired 
operation. Every wizard page has context help at the click of a button. 

Wizard Interface 
DriveBackup!’s intuitive wizard interface guides you through the backup, restore and emergency 
recovery processes. Each wizard is divided into easy steps, separated on individual wizard pages. Simply 
complete a page and click next to move on to the next page. Before you know it, your work is done and 
DriveBackup! is busy completing the selected task.  

The Backup Wizard 
You want to backup all the data on your hard drive or partition? The Backup Wizard is your choice. 
This three-page wizard is simple to use. Page One gathers the “What” and “How” details about your 
backup task. Simply tell it what disk drive/partition you want to backup and optionally, tell the wizard if 
you want to use data compression or password protection for this backup and you’re off to page two!  
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Page two handles the target device information. You specify the target device, a name for your backup 
set and the recording format to use with this drive. Once you have page two completed, the Backup 
Wizard can take it from there. Clicking next starts the backup job…your work is done and the Backup 
Wizard’s has just begun! 

The third and final page displays the details of the backup job in progress. Job summary details like 
backup source and target drives, backup speed measured in MB/Minute, elapsed and remaining times 
and a job progress bar keep you informed on the backup task being done. Once the job has completed, 
you can view the backup summary report with a click of your mouse. 

Note: 
³ You can use the Browse button on Page 2 to save your backup image on a network device. 

The Restore Wizard 
No backup program is complete without the ability to restore data previously saved or backed up. 
DriveBackup!’s Restore Wizard handles this task effortlessly. Like the Backup Wizard, this three-page 
wizard is quick and easy to use. Page One gathers the “What” details about your restore job. Simply tell 
it what backup set you wish to restore and you are ready for page two. This page asks you where you 
want to restore the backup data. All the drives that are installed on your computer are listed.  You 
specify the target device and the Restore Wizard finishes the job for you.  

Again, the third page displays the details of the job in progress. Job summary details like backup source 
and target drives, backup speed, elapsed and remaining times and a job progress bar keep you informed 
on the restore operation in progress. Once the job has completed, you can view the summary report 
with a click of your mouse. 

Notes: 
³ You can use the Browse button on Page 2 to restore your drive from a backup image 

previously saved on a network device. 

³ You cannot restore your system partition(usually the C: drive) while in Windows. You must 
use the DOS-based restore utility for this purpose. We highly recommend that you only use 
an Emergency Recovery CD/DVD for this purpose! 

The Emergency Recovery Wizard 
The Emergency Recovery Wizard takes the guesswork out of disaster recovery. The wizard senses the 
operating system and walks you through the process of creating a bootable Emergency Recovery Disc 
that can recover your system in the event of loss of a hard drive due to mechanical failures or virus 
attacks. Should a disaster happen, simply boot from the Emergency Recovery Disc and restore your 
hard drive (system partition) to the state it was when you created your Emergency Recovery Disc. 

Notes: 

0 DriveBackup! does not support restoring your system from a SCSI CD/DVD device under 
Windows NT, 2000 and XP. The Wizard requires a Start-Up diskette from a legally licensed 
Windows 98 system to provide this functionality under these operating systems. 
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Creating a Drive Image Backup 
As mentioned earlier, the Backup Wizard is a three-page wizard as follows: 

Page 1 – Selecting the Backup Source 
This page selects the drive to be backed up by the Backup Wizard. You may also change the 
compression level, add password protection, or change the backup file size settings by clicking the 
Options… button. 

 

ª To complete this page: 

1. Select the drive(partition) to be backed up from the drive list. Only drives that are 
physically installed on your computer will be available on the drive list. 

2. You may click the Option… button to change the compression settings,  add password 
protection, or change the backup file size for your backup image file. 

3. Click Next to continue to the next page. 
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Page 2 – Selecting the Destination 
This page selects the destination drive to be used by the Backup Wizard.  

 

ª To complete this page: 

1. Select the target device from the drive list. 
2. Enter a name for your backup image file.  
3. Click Next to begin the backup operation. 

Notes: 
³ You may click the “Use multiple CD writers to backup” option to enable Drive 

Spanning. You must have multiple CD/DVD writers installed on your system to 
see this option. 

³ You may click on the “Erase” button if you want to erase the CD-RW media in the 
target drive.  (See Erasing a CD-RW Disc on page Erasing a CD-RW Disc for 
additional information.) Only available on CD/DVD devices! 

³ Use the browse button to select a specific folder to save your backup image when a 
hard drive is selected from the target drive list box. 

³ All mapped network drives will appear in the target drive list box. Non-mapped 
network drives can be accessed via the browse button. You must have the 
appropriate permissions to  write to the network drive you select. 

Page 3 – In Progress 
This page displays the progress of each of the backup operation. Upon completion, you may view the 
report log for this backup operation or exit the wizard. 

ª To complete this page: 

1. Click the View Report button to see the results of the backup operation or click Finish to 
exit the wizard and return to the opening screen. 
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Restoring from a Drive Image Backup 
The Restore Wizard is a three-page wizard as follows: 

Page 1 – Selecting the Image File 
This page selects the backup image to be restored by the Restore Wizard. 

 

ª To complete this page: 

1. Enter the full path and filename of the backup set to be restored or click the browse 
button and select the desired backup set to be restored. The backup information for the 
selected file will be displayed when the backup set is successfully opened.  

2. Click Next to continue to the next page. 

Note: 
³ Network drives can be accessed via the browse button. You must have the 

appropriate permissions to any network drive you select. 

22     Using Backup NOW! 



U S I N G  B A C K U P  N O W !  

Page 2 – Selecting the Destination 
This page selects the destination drive or partition to be restored. 

 

ª To complete this page: 

1. Select the drive to be restored from the drive list.  

2. Click Next to begin the restore operation. 
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Page 3 – In Progress 
This page displays the progress of the restore operation. Upon completion, you may view the report log 
for this restore operation or exit the wizard. 

ª To complete this page: 

1. Click the View Report button to see the results of the restore operation or click Finish to 
exit the wizard and return to the opening screen. 

Notes: 

0 Restored NTFS partitions cause the chkdisk utility to be run when the system is 
rebooted to verify their proper operation. Windows NT/2000/XP will run the 
verification process and then restart. The restored drive should be fully operational 
once Windows has restarted.  

0 The target partition may be larger than the original partition where desired. You 
cannot select a partition that is smaller than the amount of data on the original 
partition. In some cases (e.g. Windows 2000, Service Pack 2), you may need select a 
target partition that is the same size as the original partition. 

³ When you select a target drive to restore, you must pay attention to the compatibility 
of the File Systems (e.g. FAT16, FAT32, or NTFS) between the source backup set and 
the target partition. The following tables list all compatible combinations of source and 
target, and the resulting partition format. Any combination not listed here is not 
supported. 

(1) If Drive Image Restore within Win32 application 
Source Partition Target Partition Resulting Partition  

NTFS NTFS NTFS 
NTFS FAT16 NTFS 
NTFS FAT32 NTFS 
FAT16 FAT16 FAT16 
FAT32 FAT32 FAT32 

All other combinations are not supported 

 

(2) In command-line Drive Image Restore 
Source Backup File Restore Target 

Partition Format 
Result Partition Format 

NTFS NTFS NTFS 
NTFS FAT16 NTFS 
NTFS FAT32 NTFS 
NTFS Non-formatted NTFS 
FAT16 FAT16 FAT16 
FAT32 FAT32 FAT32 

All other combinations are not supported 
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What is the Backup NOW! Scheduler?  
Backup NOW! Scheduler is a backup monitoring program, which Backup NOW! uses to manage its 
scheduled backups. Using the Backup NOW! Scheduler, you may remove, suspend or terminate already 
scheduled backup jobs. A Backup NOW! Scheduler icon will show up on the System Tray, which 
resides on the Windows taskbar. To bring up Backup Scheduler, point your mouse to the NTI Backup 
Scheduler icon on the System Tray, and then right click. Choose Open from the popup menu. 

Note: 

0 The NTI Backup Scheduler must be running to be able to execute scheduled backup jobs! 

Using the Scheduler 
Using the Schedule function, you may set the date and time you wish to back up your data, then the 
NTI Backup NOW!® will perform unattended backups without user interaction. 

ª To schedule a backup job: 

1. Click the Schedule button in any of the Backup windows. 
2. The following “Scheduler Setup” dialog box will be displayed: 

 
3. Select either Once, Daily, Weekly, or Monthly radio button from the dialog box. 
4. Enter the date and time you wish the NTI Backup NOW!® to perform the scheduled 

backup. 
5. Click OK. 

Notes: 

0 The scheduler can use only backup jobs that have been saved as a .bjf file. If you have 
not saved the current backup definition as a backup job file the Backup NOW! will ask 
you to save your settings in a job file before allowing you to schedule the job for later 
execution. 

0 The NTI Backup Scheduler must be running to be able to execute scheduled backup 
jobs! 

³ If a backup requires more than one disc, users need to manually change the media when 
the first disk is full. Although Backup NOW! supports media spanning, care must be 
taken to avoid this situation for unattended backups. 

³ All scheduled backup jobs can be viewed from the Backup NOW! Scheduler.  
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ª To remove a scheduled backup job: 

1. Open the Backup NOW! Scheduler window. 
2. Select the backup job to be removed from the scheduler window. 
3. Click the Remove item from the Program Menu. 
4. Click Yes on the confirmation dialog to remove the selected backup job. 

ª To suspend the Backup NOW! Scheduler: 

1. Open the Backup NOW! Scheduler window. 
2. Click the Suspend Scheduler item from the Advanced Menu. A small checkmark will be 

visible to the left of the Suspend Scheduler item when the scheduler has been suspended. 
No backup jobs will be executed while the scheduler is suspended. 

ª To resume the Backup NOW! Scheduler: 

1. Open the Backup NOW! Scheduler window. 

2. Click the Suspend Scheduler item from the Advanced Menu. The small checkmark 
should no longer be visible and scheduler operations are resumed. Scheduled backup 
jobs will be processed normally. 

ª To terminate the Backup NOW! Scheduler: 

1. Open the Backup NOW! Scheduler. 
2. Click the Terminate Scheduler item from the Advanced Menu. 
3. Click OK on the confirmation dialog to exit the scheduler program. No backup jobs will 

be executed while the scheduler is not running. 
Scheduler Job Logs 
The Backup NOW! Scheduler maintains a log for every backup job it monitors. These logs provide 
status information for each scheduled job. 

ª To view the log for a scheduled backup job: 

1. Open the Backup NOW! Scheduler window. 
2. Select the backup job whose log you wish to view. 
3. Click the View Log item from the Advanced Menu. 
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Menu Commands for Backup NOW! Scheduler 
All NTI Backup NOW! Scheduler menus can be invoked by a single left-button click of a mouse on the 
menu bar. Menu items are aligned on the left, with keystroke shortcuts (if applicable) displayed on the 
corresponding right side. The underlined character of a menu item, if pressed (through the keyboard), 
will have the same effect as if the menu item were selected with the mouse. 

Program 

 
Remove 
Removes the selected Backup Job from the window. 

Close 
Closes the scheduler window but the program remains running in the background. The 
system and scheduler must be running to start any scheduled backup job. 

Advanced 

 
Suspend Scheduler 
Suspends the Scheduler from performing scheduled backups. 

Terminate Scheduler 
Halts the execution of the Backup NOW! Scheduler. The scheduler must be restarted for 
scheduled backups to be performed. 

Note: 

³ Backup jobs will not be removed even if the Backup Scheduler is terminated. 

View Log 
Displays the log file for the selected job. 

 Help 

 
Help Topics 
Brings up On-line help. 

About Backup NOW! Scheduler 
Displays program information, Version number and copyright. 
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Chapter 4 — Topics of discussion 
 

Backup NOW! Tools & Utilities 
Completion Reports 
Erasing a CD-RW Disc 
Comparing Two File Folders 
Backup and Restore Options 
CD Drive Properties 
Media Spanning 
Drive Spanning 
Choosing a Backup Method 
 

Error Messages 
The Error Log 
Error Messages 
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Backup NOW! Tools & Utilities 
NTI Backup NOW!® contains several useful utilities that will help you in better managing your backups, 
as well as extend the usage of a CD/DVD media by being able to create a bootable CD/DVD. It also 
includes an erase utility, which will erase the contents of a CD-RW, DVD-RW or DVD+RW disc.  

Completion Reports 
Backup NOW! generates a completion report at the end of every backup, restore or compare operation. 
These reports can contain a list of all files selected for a given operation and the status of the operation. 
You will want to view these reports to be sure that an operation was completed successfully. A report 
may be viewed upon the completion of an operation. All reports are saved in the Backup NOW! 
Reports folder where they can be viewed later if necessary. 

ª To view a Backup Report:  

1. Select the View Backup Reports… item from the View Reports Menu of the Tools 
Menu. 

2. Backup NOW! displays the  Backup Report dialog box. 

 
3. Select the report you would like to view from the list of reports. 
4. Click View to display the report in Windows’ Notepad or Remove to delete the selected 

report. 

 
5. Click Close to return to the Backup NOW! window. 
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ª To view a Restore Report:  

1. Select the View Restore Reports… item from the View Reports Menu of the Tools 
Menu. 

2. Backup NOW! displays the  Restore Report dialog box. 

 
3. Select the report you would like to view from the list of reports. 

4. Click View to display the report in Windows’ Notepad or Remove to delete the selected 
report. 

 
5. Click Close to return to the Backup NOW! window. 
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Erasing a CD-RW Disc 
You can erase your CD-RW media directly from the Backup NOW! Tools Menu. You can choose 
either a Quick Erase or Full Erase. The quick erase function overwrites the existing table of contents, 
thus reducing the time it takes to erase a CD-RW disc to just a few minutes. The full erase function 
erases all data on the disc and takes a considerably longer amount of time to complete. A full erase 
however restores the CD-RW media to a more reliable state. 

ª To erase a CD-RW disc: 

1. Select the Erase CD-RW disc item from the Tools Menu. 

 
2. Select the CD-RW drive that contains the CD-RW media that you would like to 

erase from the CD-RW Drive list. 

3. Select either Quick or Full for the Type of erase option. For reliability reasons, it is 
recommended that you choose the Full erase option. 

4. Click Start to begin erasing. 
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Comparing Two File Folders 
It is possible to compare the contents of two folders on your system using Backup NOW!’s Compare 
Files function. This utility is useful, for example, when you want to compare a backup copy to its 
original. Otherwise, this is a general tool for comparing the contents of similar directories. 

ª To compare the contents of two folders: 

1. Select the Compare Files… item from the Tools Menu.  

2. Enter the locations of folders you wish to compare in each text field. If you don’t know 
the location of the folder, click on the browse button next to the text fields to search for 
the desired folders. 

3. Click on OK. 

The comparison result will show files that exist in one folder but not the other, files that 
are identical, and files that are different (i.e. “not compared”). The following is a sample 
output. 

 

Setting Backup and Restore Options 
You can control how Backup NOW! performs backup and restore operations. You can click the 
Options… button on Step 3 of either the Backup or Restore function or select the Options sub-menu 
from the Job Menu. 

ª To modify the Backup/Restore options: 

1. Open the backup or restore options dialog. 
2. Click on the appropriate tab for the options you wish to change. 
3. Select the desired option settings. (See the information below for information on the 

available backup or restore options.) 
4. Click OK to save your changes and close the selected options dialog box. 

Note: 
³ Clicking the Cancel button will close the options dialog box without saving your 

changes. 

36     Advanced Topics      



A D V A N C E D  T O P I C S  

Backup Options 
You can control how Backup NOW! will perform a backup operation from the Backup Options dialog.  

ª To open the Backup Options dialog: 

1. Select the Backup Options… item from the Options Menu of the Job Menu. 

Note: 
³ The Backup Options dialog is also accessible by clicking the Options… button 

from Step 3 “How” or from the Drive Image dialog during a backup operation. 
Only the General and Password tabs will be displayed for drive image backups. 

General Tab 
The General Tab contains settings to select the compression method for the backup file and provide a 
media label. You may also specify whether you want Backup NOW! to perform a comparison of the 
backed up file with the original when the backup file is created.  

 
No data compression 
Disabling data compression requires the least amount of time to complete the backup operation. It 
requires the most space on the destination disc due to larger backup files. 

Data compression 
Normal data compression uses less space for the backup than no compression. It is also faster than 
using maximal compression. 
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Media Tab 
The options on the Media Tab are used to select if a previous backup file is to be overwritten with the 
current one or the current backup file will be appended to the destination disc. It only applies if you are 
using a CD-RW recorder with CD-RW media. In case of CD-R media, backup files are always 
appended to the end. 

 
Eject the media after backup is finished 
This option tells Backup NOW! to eject the media once the backup job has completed. This is the 
default setting for this option. You may wish to disable this option in cases where you are running 
unattended backups and appending your backup jobs to the existing media. 

Append this backup to the media 
This option will let you keep the previous backup file along with the one currently being created. The 
backup will be written in addition to the previous backup, without overwriting it. 

Overwrite the media with this backup 
This option will let you overwrite the previous backup file with the one currently being created. This is 
convenient for scheduled backups, which will use the same media for backup, without having to erase 
the media manually. 

Prompt me for options 
Selecting this option causes Backup NOW! to prompt you for either the append or overwrite option 
whenever you create your backup. 

Note: 
³ The three options you see only apply to the CD-RW, DVD-RW & DVD+RW media. For 

CD-R, DVD-R & DVD+R media, only “Append this backup to the media” can be used. 
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Type Tab 
Options on the Type Tab select the type of backup you wish to perform.  

 
All selected files 
Create a complete backup of the selected files. The resulting backup file will always contain a copy of 
each file selected.  

New and changed files only 
Back up the new and changed files only, AFTER user has made a backup file with “All selected files” 
option. 

Differential 
Back up all the files that have been added or changed since the last complete backup was made using 
the “All selected files” option. 

Incremental 
Back up all the files that have been added or since the last backup operation. 

Notes: 

0 You cannot perform differential or incremental backups without having created a 
baseline backup using the “All selected files” option.  

0 It is not recommended to mix differential and incremental backups methods. 
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Include Tab 
The Include Tab specifies the types of files that you wish to back up. The file types can be either 
registered or custom. 

 

ª To add specific file types to the backup include list: 

1. Click the Add… button. The Add dialog box will be displayed. 

 
2. Select the type (Registered or Custom) of file you wish to add. 

3. If you selected Registered type, then select the registered file type you wish to include on 
the list. 

Or 

If you selected Custom type, then enter the file specification you wish to include in your 
future backups. You also need to specify the path to which this exclusion is to be applied. 
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Note: 
³ For file specification, standard Windows file naming syntax applies, you can 

use wild cards (* and ?). 

4. Click OK. 

5. To add more to the list, simply repeat the process from Step 1. 

6. Click OK from the Backup Options dialog to save the changes. 

Notes: 

0 Backup NOW! examines filters set in both the Include and Exclude lists to 
determine which files are displayed /backed up. The Exclude file list takes 
precedence over settings in the Include file listing. If a filter is accidentally added to 
both lists, files specified by that filter will not be visible/backed up. 

³ Adding a file type to the include list automatically limits the display/backup of files 
to the types on the include list.   

³ A default filter of *.* will be used if there is no entry in the Include filter list.   

³ All filters are global unless the Apply to Path options is checked. Checking the 
Apply to Path option limits the file inclusion filter to the current directory and all 
other subfolders of the current directory. 

ª To remove specific file types from the backup include list: 

1. Click on the Name(s) of, select, the file type(s) you wish to remove from the backup 
include list. 

2. Click Remove. 
3. Click OK from the Backup Options dialog to save the changes. 
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Exclude Tab 
The Exclude Tab specifies the types of files that you do not wish to back up. The file types can be either 
registered or custom. 

 

ª To add specific file types to the backup exclude list: 

1. Click the Add… button. The Add Exclude dialog box will be displayed. 

 
2. Select the type (Registered or Custom) of file you wish to add. 

3. If you selected Registered type, then select the registered file type you wish to exclude 
from the list. 

Or 
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If you selected Custom type, then enter the file specification you wish to exclude from 
your future backups. You also need to specify the path to which this exclusion is to be 
applied. 

Note: 
³ For file specification, standard Windows file naming syntax applies, you can 

use wild cards (* and ?). 

4. Click OK. 

5. To add more to the list, simply repeat the process from Step 1. 

6. Click OK from the Backup Options dialog to save the changes. 

Notes: 

0 Backup NOW! examines filters set in both the Include and Exclude lists to 
determine which files are displayed /backed up. The Exclude file list takes 
precedence over settings in the Include file listing. If a filter is accidentally added to 
both lists, files specified by that filter will not be visible/backed up. 

³ Adding a file type to the backup exclude list automatically prevents all files in the 
selected directory with that file specification from being included in future backup 
operations.  

³ All filters are global unless the Apply to Path options is checked. Checking the 
Apply to Path option limits the file exclusion filter to the current directory and all 
other subfolders of the current directory. 

³ The Windows Swap File (.SWP file in Windows 95/98, or PAGEFILE.SYS in 
Windows 2000/NT/XP) is an example of a file type that it typically excluded during 
backup operations. 

ª To remove specific file types from the backup exclude list: 

1. Click on the Name(s) of, select, the file type(s) you wish to remove from the backup 
exclude list. 

2. Click Remove. 
3. Click OK from the Backup Options dialog to save the changes. 
Note: 

³ Removing a file type from the backup exclude list will allow that file type to be 
included in future backup operations. This is not automatic, files must be reselected 
in the backup job to be included. 
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Report Tab 
Options on the Report Tab determine the items included in the completion reports for all backup 
operations. 

 
Report all files that were backed up 
This option, when selected, will include information about every file backed up in the completion report 
for the current backup operation. 
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Password Tab 
Options on the Password Tab determine if your backup files will be password protected. 

 
Enable password protection 
This option, when selected, will add password-protected encryption to the file level or drive image 
backup. 

Password  
Enter the password to be used for your backup file. 

Reenter password  
³ You must enter the desired password a second time for verification purposes. 
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Set Backup File Size Tab 
Options on the Set Backup File Size Tab determine the maximum size of the backup set for all backup 
operations. 

 
Backup File Size 
Select the maximum size allowed for a backup set before spanning. 

y Maximum File Size supported by the File System – This options writes data to the backup set 
until the selected target device is full. Media Spanning will occur, where supported, at that 
point. 

y 650 MB (Normal CD-ROM Size) – Use this option to force media spanning once the backup 
set reaches 650 MB. You can use this option to break large backups into files that can later be 
copied to CD media for safe storage. 

 Restore Options 
You can control how Backup NOW! will do a restore operation from the Restore Options dialog.  

ª To open the Restore Options dialog: 

1. Select the Restore Options… item from the Options Menu of the Job Menu. 

Note: 
³ The Restore Options dialog is also accessible by clicking the Options… button from 

Step 3 “How” during a restore operation. 
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General Tab 
Options on the General Tab determine if a file on your computer should be replaced by the backup 
copy of that file.  

 
Never replace a file with its backup copy 
Files will not be replaced with their backup copy. Used when you want to keep your current copy in the 
hard drive. 

Replace a file only if its backup copy has newer file date and time 
Files are only replaced if the backup copies are newer than the current files in the hard drive. 

Always replace a file with its backup copy 
Files are always replaced with their backup copies whether or not the backup copy is newer or older. 

Report Tab 
Options on the Report Tab determine the items included in the completion reports for all restore 
operations. 

 
Report all files that were restored 
This option, when selected, will include information about every file restored on your computer in the 
completion report. 
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Disc Info & Tools 
You may wish to check information about a disc before you decide to import any session from the CD-
ROM disc. To do this, choose the Disc Info & Tools command under the Tools menu. The “Disc Info 
& Tools” dialog box will appear. 

This box contains informational fields about the disc, including its Disc Type, Capacity, and Free Space. 
Status, and other details as shown below: 

 
 
Disc Type 
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM 
XA disc. 

Disc Status 
Blank Disc: a blank piece of media is in the selected drive.  

Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc has not 
been finalized yet. 

Unrecordable Disc: either a conventional CD/DVD or Disc has been finalized. You cannot use this 
disc to record. 

Re-Writable 
This field indicates the total recordable capacity of the disc, as expressed in the “minutes: seconds: 
frames” format. If you insert a disc, this field will show you the exact capacity of the data stored on the 
disc. 

Used Space 
This field shows the amount of used space on the disc, as expressed in “minutes: seconds: frames” and 
megabytes (MB). 

Free Space 
This field shows the free and available space on the disc, as expressed in “minutes: seconds: frames” and 
megabytes (MB). If you insert a finalized or silver disc, this field will be zero, indicating no free space. 
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Buttons  

Refresh: When you insert another CD, click this button to display updated information about the 
new CD. Or, when you want to make sure that the contents of the currently inserted disc are 
correctly displayed, click on the Refresh button. 

Erase: The erase button will be enabled if the disc in the selected drive is a erasable. You can erase 
the disc by clicking this button.  

Close Session: If there are sessions that have remained open, when you highlight the open 
session, the Close Session button will be enabled. You can click it to close the selected session. 

Close: Closes the Disc Info & Tools dialog when clicked. 

CD/DVD Drive Properties 
The Drive Properties dialog displays the read and write capabilities of the selected CD drive. You can 
also set the Backup Format for a drive using this dialog. Clicking on the CD Drive Properties item on 
the Tools Menu or clicking the property sheet button to the right of the drive selection control will 
display the Drive Properties for the selected drive. 

 
Write Capabilities: 

The write capabilities section indicates the supported write speed and indicates if the selected drive 
supports various features. 

CD Recordable – This drive writes to CD-R media at these speeds. 
CD Rewritable – This drive writes to CD-RW media at these speeds. 
DVD Recordable – This drive writes to DVD-R or DVD+R media at these speeds. 
DVD Rewritable – This drive writes to DVD-RW or DVD+RW media at these speeds. 
Buffer Underrun Error Protection – This drive supports Buffer Underrun Error Protection. 
Disc-At-Once – This drive supports the Disc-At-Once writing method. 
Session-At-Once – This drive supports the Session-At-Once writing method. 
Packet Writing – This drive supports packet writing. 
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Read Capabilities: 

The read capabilities section indicates the supported write speed and indicates if the selected drive 
supports various features. 

Max Speed – This drive will read at this speed. 

Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media. 

Media Spanning 
Media spanning is fully supported using Backup NOW!. Any backup file that exceeds the capacity of 
the existing media is split and carried over to the next CD. Extremely large backup files can be spanned 
across multiple CDs. Backup NOW! handles this automatically and prompts you when a media change 
is required for both backup and restore operations. 

Drive Spanning 
Drive spanning allows you to select multiple drives as targets for a backup job. You can use all of your 
CD burners or DVD burners installed on your system for your backup tasks. You can select all 
CD/DVD drives on your system, insert a piece of blank media in each drive and run your backup job. 
By default, Backup NOW! will use the first drive selected (in drive letter order) until that disc is full. 
Once the first drive is full, Backup NOW! will automatically start writing to the next selected drive on 
the list. This process continues until all spanned drives are full and then Backup NOW! will eject the 
tray from the first drive and prompt the user to insert another blank disc if necessary. 

Using Drive Spanning 
Drive Spanning is enabled when you check the “Use multiple CD writers to backup” option from the 
Where to backup? (Backup Step 2) screen. By default all CD/DVD drives appear in the Selected CD 
writers list in drive letter order. 

 
You can use the arrow buttons to add, remove or reposition your drives from the selected writer list. 
Perhaps you do not want to use that old 4x burner or maybe use your faster drives first. It’s up to you! 
Once selected, the drives will be used in the order that they are found on the Selected CD writers list. 
Backup NOW! will write to first burner on the list and then switch to the second burner listed when the 
media in the first drive is full. Once the media is full on all drives then you will be prompted to insert a 
new piece of media in the first drive before the backup job can continue.  
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ª To configure and use Drive Spanning during a backup job: 

1. Complete Step 1 as described in Chapter 2. 

2. Compete Step 2 and check the “Use multiple CD writers to backup” checkbox. 
3. Use the arrow buttons to edit the Selected Drive List. 
4. Complete Step 3. 
5. Insert blank media in all drives on the Selected Drive list. 
6. Click Start to execute your backup job. 
Notes: 
³ You can Save, Schedule or execute the backup job.  Your Drive Spanning options will 

be remembered each time you execute this backup job. 

³ Backup NOW! will start backing up your data to the first drive on the Selected Drive 
list. Once that disc is full, Backup NOW! continues the backup job on the next drive 
on the list. This type of spanning continues until either the backup job has completed 
or all media in the selected drives is full. At this point, Backup NOW! will start over at 
the top of the Selected Drive list and prompt you to insert a new piece of blank media 
in the first drive. 

Choosing a Backup Method 
This section describes how the incremental and differential backup methods work. It includes an 
example of using each type of backup and discusses the steps required to restore from both to illustrate 
the pros and cons of each method. It is up to you to decide which method to go with in your backup 
plan. Incremental backups require less space but as you will see, can take significantly more work during 
restore operations. Differential backups are the opposite. If restore time is your main consideration then 
differential backups would likely be your best choice. If conserving space is the concern then 
incremental backups is the way to go. Remember that both backup types require a full backup as a 
baseline to produce a reliable backup of your data. 

Example 1 – Incremental Backup & Restore 
This example illustrates the “Incremental” backup method. As mentioned previously, incremental 
backups only include files added or modified since the last back up. 

 The following are in chronological order: 

Day 0: There are two files in your backup set: MyFile1, and MyFile2. You make a File Level 
Backup with “All selected files” option. This “baseline” backup contains both MyFile1 
and MyFile2. 
 

You make changes to MyFile2 and add a new file, MyFile3. 

Day 1: You make an “Incremental” backup. The backup file contains only MyFile2 and 
MyFile3—MyFile1 has not changed since the last backup so it is not included in the new 
backup. 
 

You make changes to MyFile3 and add a new file, MyFile4. 

Day 2: You make an “Incremental” backup. The backup file contains only MyFile3 and 
MyFile4—Neither MyFile1 nor MyFile2 has changed since the last backup so they are 
not included in the new backup.  
 

You add a new file, MyFile5. 
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Day 3: You make an “Incremental” backup. The backup file contains only MyFile5—No other 
files have since the last backup so they are not included in the new backup. 

Example 2 – Differential Backup and Restore 
The differential backup method includes all filed that have been changed or added since the last full 
backup.  

The following are in chronological order: 

Day 0: There are two files in your backup set: MyFile1, and MyFile2. You make a File Level 
Backup with “All selected files” option. This “baseline” backup contains both MyFile1 
and MyFile2. 
 
You make changes to MyFile2 and add a new file, MyFile3. 

Day 1: You make a “Differential” backup. The backup file contains only MyFile2 and 
MyFile3—MyFile1 has not changed since the last baseline backup so it is not included in 
the new backup file. 
 
You make changes to MyFile3 and add a new file, MyFile4. 

Day 2: You make a “Differential” backup. The backup file contains MyFile2, MyFile3 and 
MyFile4—MyFile1 has not changed since the last baseline backup. 
 
You add a new file, MyFile5. 

Day 3: You make a “Differential” backup. The backup file contains MyFile2, MyFile3, MyFile4 
and MyFile5—MyFile1 still has not changed since the last baseline backup. 
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Which backup method is best for me? 
As you can see, the backup files created using the differential backup method will be larger as the 
number of days from the last baseline backup increases. The more files added or changed the more files 
that are recorded in each new differential backup. Incremental backups are smaller as demonstrated in 
the examples above. 

However, what about restoring from each of these backup types? Well, to fully restore all five of these 
files using the incremental backup method, you would first restore the baseline backup. Once the 
baseline backup has been fully restored, you must restore each subsequent incremental backup. This 
ensures that you will now have all new files as well as the latest version of each file that has been 
modified since the last baseline backup was created. You can quickly see that as the numbers of days 
from the last baseline backup increases, the number of restore operations required to recover all your 
files also increases. The amount of work to recover you data is a function of the number of incremental 
backups since the last baseline backup. 

Now what about restoring files backed up using the differential backup method? A quick look at the 
backup created on Day 3 shows that it contains all of the new files added since the baseline backup. It 
also contains the latest version of any file that has been modified since the last baseline backup. We can 
see that the restore process can be completed in two restore operations: restore all files from the last 
baseline backup and the latest differential backup file, regardless of how many differential backups have 
occurred since the last baseline backup. Again, as you can see, differential backups are larger but 
recovery can always be completed in two restore operations.  

There is one last consideration: unattended backups. You can easily setup and schedule the daily 
backups from our examples using Backup NOW! and the Backup NOW! Scheduler. Backup NOW!’s 
media spanning feature will automatically span your backup images across multiple CDs/DVDs but 
somebody needs to change the media should spanning actually occur. There are two things to consider 
about media spanning. First, large backup files can trigger spanning. Any file that would exceed the 
available capacity of the current disc will be spanned to another disc. Since differential backups tend to 
be much larger, the spanning issue is more likely to occur when using the differential backup method. 

The second consideration is the “Append this backup to the media” option found on the Media tab of 
the Backup Options settings. This option allows you to write more than one backup file to a 
CD/DVD, thereby saving media costs. Multiple backups saved to the same media increase the chance 
that media spanning will be required. If you select this option and are running unattended backups care 
must be taken to monitor the amount of available space on the target media after each backup. Even 
incremental backups will eventually trigger the media spanning feature after enough backups have been 
performed. 

As this discussion illustrates, choosing which backup method will depend on many factors. The quantity 
of data to be backed up, rate of changes made to existing files, rate of file additions to your system, 
unattended backup and the frequency of backups in your backup plan all must be evaluated before 
choosing the backup method that best works for you. Every situation is different but understanding 
these factors will help you make the best choice for your environment. 

Note:   
³ Drive Spanning will fill all discs on all spanned drives before requiring the user to change media. 

This can help eliminate the problems caused by media spanning on systems containing multiple 
CD/DVD recorders. 
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Error Messages 
The Log File 
NTI Backup NOW! will create log files (or completion reports) that allow you to trace and diagnose 
problems that can occur during backup, restore, or compare operations. Please refer to the 
“Completion Reports” section on Chapter 4. 

Error Messages 
 
General Errors 
 

Error: Failed to open file. 

Analysis:  The backup image file (.nbf or .npf file) cannot be opened for reading. The file may 
have been damaged or incorrectly created. 

Solution:  Use good brand-name media discs, as this error is often associated with bad media. If 
you use a CD-RW disc that has been written many times, we recommend that you do a full erase 
before using it again for backup. 

Error: Files not compared. 

Analysis:  The backup copy stored in the backup image does not compare with its original file. 

Solution:  The file has been modified since backup. This happens often to active system files or 
temporary files. Such cases are normal and no errors have occurred.  

Error: Insufficient Disk Space for restore 

Analysis:  There is not enough space in the target drive (partition) to restore the selected files or 
drive image. 

Solution:  Choose a target drive with sufficient space. 

Error: Failed to prepare registry files for backup 

Analysis:  Failed to access the registry due to user permission restrictions (in Windows 2000 and 
NT), or registry files are damaged. 

Solution:  In Windows 2000, XP and NT, you must log on as a member of the Administrator’s 
group to be able to access the Registry. 
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Error: Backup completed with skipped file(s). 

Analysis:  Failed to open or read certain file(s), which is (are) skipped. 

Solution:  Check your access rights to these files. Make sure these files are not in use or locked by 
other applications or users. In Windows 2000, XP and NT, we recommend that you log on as 
Administrator. 

Error: Restore completed with skipped file(s). 

Analysis:  Failed to restore certain file(s) due to access restrictions. 

Solution:  Check your access rights to these files. Make sure these files are not in use or locked by 
other applications or users. In Windows 2000, XP and NT, we recommend that you log on as 
Administrator. 

Error: Invalid Drive Image backup file 

Analysis:  The drive image backup file on disc is either incorrectly created or damaged. 

Solution:  Retry the backup to create a good drive image backup file. We recommend that you 
use good name-brand media, especially for CD-RW. 

Error: Data compression (or decompression) error. 

Analysis:  Failed to read the compressed file on backup image file. The file may have been 
damaged. 

Solution:  Retry the backup to create a good backup image file. We recommend that you use 
good name-brand media, especially for CD-RW. 

 
ASPI Manager Errors 
 

Error: An incompatible ASPI Manager is installed. 

Analysis:  The SCSI card and ASPI Manager are not supported by NTI Backup NOW!. 

Solution:  Make sure the ASPI Manager and SCSI card are supported by NTI Backup NOW!. 
Please refer to the System Requirements in Chapter 1 in this manual. 

Error: No ASPI managers were found! 

Analysis:  The ASPI device driver was not installed before you ran the program. 

Solution:  Install the ASPI Manager. For instruction of how to install, please refer the documents 
provided by the SCSI card manufacturer. 

Error: ASPI for Windows failed to initialize. 

Analysis:  ASPI for Windows did not properly load/initialize in memory. This may be caused by 
a lack of system resources and/or mismatched ASPI file version(s).  

Solution:  Make sure the CD Recorder is connected to the PC and the power is on. Exit 
Windows and reboot the system. Then try it again. You may be required to re-install the ASPI 
device driver files if this error is a recurring problem.  
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CD-ROM Drive & CD Recorder Errors 
 

Error: No supported CD Recorder found 

Analysis:  Either your CD-R/RW drive is not yet supported by your current version of NTI 
Backup NOW!, or your drive is not installed correctly. 

Solution:  Check NTI web site www.ntius.com for drive support information. Make sure your 
drive is properly installed and connected. 

Memory & Hard Disk Space Errors 
 

Error: Out of memory. 

Analysis:  There is not enough memory. 

Solution:  Close other applications and try again. If it still can not be solved, reboot your system, 
and try again. 

Error: Fatal memory lost. 

Analysis:  This is a memory management error. 

Solution:  Close all the applications, reboot your system, and try again. 

Window’s Errors 
 

Error: Cannot set timer. 

Analysis:  Unable to set the timer which is a Window’s resource. Close other applications and try 
again. 
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Chapter 5 — Topics of discussion 
 

Emergency Recovery Wizard 
 Using Emergency Recovery 
 Running the Emergency Recovery Wizard 

Emergency Recovery Wizard 
 
Restoring your system with Silent Recovery 
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Emergency Recovery Wizard 
The DriveBackup! Emergency Recovery Wizard will help you create a bootable Emergency Recovery 
Disc for your computer. This disc can be used to recover your system to the way it was at the point 
when you created your Emergency Recovery Disc. It is always a good idea to create and keep a current 
Emergency Recovery Disc on hand for those unpredictable problems that prevent you from booting 
from your main hard drive, examples of such problems include, complete failure of an existing hard 
drive or damage done by a virus. 
NTI DriveBackup!™ can now create a bootable CD/DVD from IBM’s PC-DOS (included) or a 
Microsoft’s Windows 98/Me Startup Disk. You will need to use a Windows 98/Me Startup Disk if you 
need to recover your system from a SCSI device. In most cases, you will not need any additional 
software to create your bootable Emergency Recovery Disc regardless of the version of Windows you 
are running. 
Notes: 
0 Windows NT/2000/XP users who need to recover their system using a SCSI device must 

have access to a legally licensed Windows 98/Me Startup Disk to use this feature. 

Using Emergency Recovery  
An Emergency Recovery Disc is required to restore a lost or damaged system drive. The entire purpose 
of this disc is to get enough of the operating system back to allow you to access your CD/DVD drive 
so that you may restore your files after the damaged hard disk has been repaired or replaced. It requires 
that you have previously created a good backup of your operating system drive (using the Emergency 
Recovery Wizard as discussed below).  
In addition, it is important to realize that your new drive will be restored to the state that your system 
was in when you created the backup. Once in Windows, you will need to use DriveBackup!, or our 
companion product Backup NOW!, to restore any additional files that were located on other partitions 
of the affected hard drive. Programs and data added after the creation of the backup set cannot be 
recovered if they have not been backed up and must be re-installed. Frequent backups help to eliminate 
or minimize loss of your critical data in case of emergencies. Running the  Emergency Recovery Wizard 
periodically to keep your backup current is highly recommended. 

ª To backup and recover your operating system: 

1. Create an Emergency Recovery Disc as described previously in this chapter. 

2. Save the Emergency Recovery Disc in a safe place.  Regularly refresh your Emergency 
Recovery Disc and backup your other important data and files periodically, using 
DriveBackup!  

3. When your hard disk fails to boot, after repairing or replacing the damaged disk drive, 
follow the procedure above to restore your system to a bootable state. 

4. Boot to your restored hard drive. Once in Windows, use NTI DriveBackup!™ or NTI 
Backup NOW!® to restore any remaining files from your most current backup(s). 
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Running the Emergency Recovery Wizard 
The NTI DriveBackup!™ Emergency Recovery Wizard automatically senses the operating system you 
are running and reconfigures itself accordingly. The following sections describe the operation of the 
wizard in each supported operating system.  
Note: 

³ The pages displayed and their sequence depends on the operating system you are running. 
Please refer to the specific instructions for running the Emergency Recovery Wizard on your 
operating system. 
5.  

Emergency Recovery Wizard - Select Destination Drive(s) 
This page selects the target device(s). This is the drive(s) you will use to create your Emergency 
Recovery Disc(s). You will be required to supply a blank piece(s) of media to create a 
Recovery Disc/backup. 

 

ª To complete this page: 

1. Select the target CD/DVD drive for the Emergency Recovery Disc. 

2. Insert a blank piece of media in the selected drive(s). 

3. Click Next to continue to the next page. 

Notes: 
³ You may click the “Use multiple CD writers to backup (Drive Spanning)” option to 

enable Drive Spanning. You must have multiple CD/DVD writers installed on your 
system to see this option. 

³ You may click on the “Erase” button if you want to erase the media in the target 
drive 
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Emergency Recovery Wizard – IDE or SCSI 
From this page you tell the Emergency Recovery Wizard if you need to restore your system from an 
SCSI based CD/DVD drive. You will be required to provide a Windows 98/Me Startup disk to be able 
to recover your system from a SCSI based device.  

 

ª To complete this page: 

1. Select the appropriate option. 

2. Click Next to continue to the next page. 

Note: 
³ You will be required to provide a Windows 98/Me Startup diskette to be able to 

recover your system from a SCSI based device. 
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Emergency Recovery Wizard - Startup Source 
This page tells the Emergency Recovery Wizard where to find the files necessary to create an 
Emergency Recovery Disc.  

 

ª To complete this page: 

1. Select the floppy drive to be used to read the Windows 98/Me Startup Disk.  

2. Insert the Startup Disk in to the selected drive. 

3. Click Next to continue to the next page. 

Notes: 
³ If you are running Windows 98/Me then you may click on the “Create Startup 

Disk…” button if you need to create a Windows Startup diskette before continuing 
with the Emergency Recovery Wizard.  

³ NTI DriveBackup!™ will read the systems files necessary to create a bootable 
Recovery Disc before continuing on to the next page. These files are saved by 
DriveBackup! as a bootable image file that may be used during future backups. 

³ This page is only displayed if you selected the Restore from SCSI drive option on 
the previous page.  

³ This page may be bypassed if you have previously created a bootable Recovery Disc 
and answered “Yes” to the prompt to use the existing bootable image file.  
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Emergency Recovery Wizard - Select Backup Source 
This page selects the drive to be backed up by the Emergency Recovery Wizard. Normally, this would 
be the drive with the operating system on it. This is the image that will be restored when you boot from 
your Emergency Recovery Disc. You may also specify a name for your backup image from this page. 

 

ª To complete this page: 

1. Select the drive to be backed up from the drive list. Only drives that are installed on your 
computer will be listed. 

2. You may click the “Option…” button to change the current settings or add password 
protection to your Recovery Disc. 

3. Enter a name for your backup image file. The boot files will be configured to restore the 
image with this name. It must comply with the DOS 8+3 file naming convention. In 
most cases, it is neither necessary nor recommended to change the default name. 

4. Click Next to create the Recovery Disc. 

Note: 
³ If you used a Startup diskette on Page 3 of this wizard please remove the Startup 

diskette and insert a blank, formatted diskette in the floppy drive before continuing 
(clicking the Next button) with the Emergency Recovery Wizard.  

Emergency Recovery Wizard - In Progress 
This page displays the progress of each of the steps during the creation of the Recovery Disc.  

ª To complete this page: 

1. Click the View Report button to see the results of the backup operation or click Finish to 
exit the wizard and return to the opening screen. 
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Restoring your system with Silent Recovery 
Once disaster has struck, you want to get your computer back up as quickly as possible. No need to 
panic. You have prepared for this day back when you created your Emergency Recovery Disc. Once 
you have replaced, repartitioned and formatted your failing hard drive you are ready to recover the 
system files and restore your Windows environment. Simply set your system to boot from the 
CD/DVD drive in your system BIOS and insert your Emergency Recovery Disc in that drive. Your 
machine will boot from the Emergency Recovery Disc and start to recover your system. Once the Silent 
Recovery utility has completed its work, simply remove the Emergency Recovery Disc, configure your 
system to boot from the recovered drive (if necessary) and reboot your computer. Your system should 
now be up and running with the drive restored to the state that it was in when you created your 
Emergency Recovery Disc. Once you are back up and running in the Windows environment you can 
restore any other partitions using the NTI DriveBackup!™ Restore Wizard and your important data 
files using our companion product, Backup NOW! 

ª To restore from an Emergency Recovery Disc: 

1. If you are restoring from a Recovery Disc, then you must do one of the following: 

For IDE Drives – Set your CD-ROM/DVD-ROM drive to come first in the boot 
sequence (e.g. “CD-ROM, A, C”) in your BIOS settings.  

For SCSI Drives – Select the “Enable bootable CD” option in the adapter settings, 
if your adapter supports it and set SCSI to come first in the boot sequence (e.g. 
“SCSI, A, C”) in your BIOS settings. 

2. Insert the Emergency Recovery Disc in your CD/DVD drive and then reboot your 
computer. 

3. Your system should boot and begin the Silent Recovery utility.  

4. At the prompt, select the partition you wish to recover then hit Enter. In most cases, 
your system partition will be the first on the list. 

5. Reboot your computer into Windows after the restore operation has completed. 

Notes: 

0 Restored NTFS partitions cause the chkdisk utility to run when the system is 
rebooted to verify their proper operation. Windows NT/XP/2000 will run the 
verification process and then restart. The restored drive should be operational once 
Windows has restarted.  

0 The target partition may be larger than the original partition where desired. You 
cannot select a partition that is smaller than the amount of data on the original 
partition. In some cases (e.g. Windows 2000, Service Pack 2), you may need select a 
target partition that is the same size as the original partition. 

0 In most cases, it is not possible to restore your system from a USB or Firewire 
device. This is because the necessary device drivers are not loaded until Windows is 
running. You can create the Recovery Disc on your USB/Firewire CD/DVD 
recorder and then use any non-USB/Firewire CD/DVD drive attached to your 
computer to restore your system from the Emergency Recovery Disc. 
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Chapter 6 — Topics of discussion 
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Getting the most out of Backup NOW! 
So now, you have learned how to use Backup NOW! and are wondering what you do next. In this 
chapter, we will provide suggestions on getting the most from your Backup NOW! and DriveBackup! 
software. We will start out by using DriveBackup! to make an Emergency Recovery CD complete with 
a drive image backup of your system drive. That will provide you failsafe configuration should you ever 
find yourself faced with the kinds of system problems that prevent you from booting your system. 

After that, we will review the different backup methods and suggest a backup plan using Backup NOW! 
As always, these are just suggestions and you may want to alter them or create your own backup plan 
based on your specific needs. 

Preparing for that rainy day! 
While we all know it could happen, we talk ourselves into believing that it will never happen to us. 
Don’t you just know it…it happened! Our system crashes, or we caught the latest “nasty” little virus 
running around the web, and we cannot boot our computer. What happens next is determined by a few 
simple decisions we made a long time ago. Did you create an Emergency Recovery CD?   Did you 
develop a backup plan as a safety net?   Did you follow that plan? 

If you answered “No!” to any of the above you may find yourself facing many long frustrating hours of 
recovering your PC some day in the not too distant future. You may even find that you need to go out 
and hire your local “guru” to get you back up and “surfing the net.” In addition, it is very likely that you 
have lost some of your important data forever! 

NTI BackupNOW! brings you a step closer to avoiding the above “nightmare.” Combined with your 
CD/DVD recorder, NTI BackupNOW! can save the day! Of course, it takes a little help from you but 
we can do it together. It only takes one encounter with the situation above to realize that the importance 
of preparing for that rainy day! 

NTI’s BackupNOW! Recommendations: 
The following are a few recommendations for getting the most from BackupNOW! and DriveBackup! 
software. 

Recommendation #1 – Consider the media quality and type 
When using CD, your first choice is “Do I use CD-R or CD-RW for my backups?” There are a few 
important things to remember before you make this choice. First, CD-R media is more stable and in 
that sense, more reliable than the newer technologies found in CD-RW media. It is also faster meaning 
that you can reliably record at a higher speed than is available on a CD-RW  disc. Currently, CD-RW 
technology is catching up and reaching recording speeds of up to 16x. Today’s new drives can record to 
CD-R media at speeds up to 48x so CD-R technology still enjoys a significant advantage in this area. 
Therefore, if the amount of data or time available to perform a backup is a factor you may want to use 
CD-R media instead. Backup NOW! Version 3.0 adds DVD and local and networked disk drives to 
your list of options to consider here. Generally speaking, the amount of data you have to backup may 
make DVD a more suitable option.  

The second consideration is one of quality. You will find that different media performs differently on 
your drive and from one drive to the next. It is highly recommended that you do not exchange media 
quality for cost savings when it comes to backing up your important data! It is always your choice but 
finding out that it was a bad choice while trying to recover your system doesn’t make sense. You are 
taking the steps necessary to safeguard your system. Now is not the time to get experimental with the 
quality of your backup media!  
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One final note, store your back up media in a safe and protected location. Different dyes used in the 
production of a piece of media react differently to things like being stored in harsh temperatures and 
direct sunlight. All media is different and so it is not a good idea to take unnecessary chances with your 
backup discs. 

Recommendation #2 – Test and verify your backup solution 
The bottom line is simply this…make sure it works before you trust that your data is safe. This is your 
responsibility to yourself and your valuable data. Once you have developed your backup plan then test 
it…including as many recovery scenarios as possible. If you think of it now and verify that your solution 
protects you in that situation then you will be in much better shape should a disaster strike. In the best 
of cases, you will never need your backup data but it is much better to know it is there and that it works! 
And always remember Recommendation #1 above…the media matters, in both type and quality. You 
may want to experiment with both CD-R and CD-RW media as well as different brands during your 
testing process. Your drive and the media you select are members of your backup team and 
unfortunately, not all players get along with each other. 

Recommendation #3 – Create an Emergency Recovery Disc 
As discussed in previous chapters, an Emergency Recovery Disc contains enough of the operating 
system to allow you to boot your computer into DOS. It also contains various diagnostic and repair 
tools for your system and disk drives. Finally, it contains the drivers required to access your CD/DVD 
drive and restore your system from a previously created backup. 

For step-by-step instructions to create a Recovery Disc, see “Emergency Recovery Wizard” on Page 59 
of this guide. 

Recommendation #4 – Backup your system drive to your Recovery Disc 
This recommendation is just Step Two of creating an Emergency Recovery Disc. The important part 
here is that you have a good, drive image backup of the drive that contains your operating system files. 
In most cases, your system drive will be your C drive but that is certainly not a requirement.  

In many cases, your system drive has changed considerably from the time you made this drive image. 
The main purpose here is to restore enough of the operating system to run Windows again. Once you 
reboot into Windows, run NTI DriveBackup!™ or NTI Backup NOW!® and restore your system using 
the latest backups as created by your backup plan.  

For step-by-step instructions to create a drive image backup, see “Creating a Drive Image Backup” on 
Page 20 of this guide. 

Recommendation #5 – Design your backup plan 
This recommendation is more of a guide really and is not to be taken as the only way to use 
Backup NOW! for backing up your critical data. In fact, it is a pair of basic plans, one using incremental 
backups and the second using differential backups to accomplish the task of backing up your data. 
There are many factors to consider when developing your own plan. We’ll recap a few of them here and 
then present each plan. It is up to you to decide which plan will work for you. You will probably 
discover that your plan will be different than either of the samples provided here. 
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Factors to consider in your backup plan 
As you will quickly discover, there is no one “RIGHT” way to design your backup plan. The factors 
listed here are just a few and not intended to be an exhaustive list of things to consider. You will also see 
that they all are interrelated. If you choose this option, it will likely impact you in some other place. 
What you are looking for is the “best fit” for your computing environment. 

• What types of data should be backed up? 
This question wants you to begin to think about the big picture. Any backup takes time and 
space. There is an associated cost in terms of both time and money to backup your system’s data. 
There is also a cost for losing that data should your system not be able to access it. Everything has 
a price and it is up to you to make a decision about what is and isn’t important to backup. 

In general, remember this! Most everything can be replaced. Program files can be re-installed and 
even the computer itself can be replaced. The most difficult thing to replace is user data. Your 
data files of your home finances, any business records that you may have, tax information, letters 
that you write and the pictures and recipes are examples of user data you may have on your 
computer. Data is the most difficult to recover if it is not backed up. In some cases, it may never 
be replaced or replaced at considerable cost to you. It is time to start thinking about what data you 
have on your computer. 

• What data will be backed up? 
Well, have you identified the critical items that you need to backup? Just remember that selecting 
too much data for a backup has a cost but failing to backup irreplaceable data may cost even 
more. If you feel that the amount of data you wish to backup is too large, remember, programs, 
drivers and other operating system files can be recovered by reinstalling them from their original 
media in many cases. User data usually can only be replaced manually if at all. 

• How often is this data modified? 
This information can help you decide which backup method to use as well as how frequently you 
will want to schedule your backup jobs. It is also important to think in terms of maximum 
exposure when deciding on your backup job schedule. How much data can be lost between 
backups? What will it cost, in terms of time, money or both, to manually re-enter or recover the 
data if your system goes down and you cannot access your data? Can it be recovered manually? If 
not, then what? 
 

While most of these issues are more clearly defined in a business environment, home users must 
face them too, especially if you work out of your home or use your computer for your home 
based business! 

 

• How much data is being backed up?  
The amount of data being backed up is important when you consider the backup method for 
your plan. Will you use compression with your backup jobs? Will I need to schedule my backup 
jobs to run late at night when nobody is around to monitor the process? Generally, the more data 
the more time it will take to restore. Data compression reduces the space requirements of the 
resulting backup image but usually at the expense of time. As mentioned previously, media 
spanning can be an issue when you schedule an unattended backup. Backup NOW! will 
automatically span a backup image to another disc should the first disc become full. A backup job 
may be left suspended, waiting for a new disc to be inserted, should this occur. 
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Incremental vs. Differential backups 
The differences between these backup methods and their pros and cons have been discussed in detail in 
previous chapters. Rather than to rehash them, we will include a sample backup plan for each method.  

When we refer to “selected files,” it is understood that you will decide which files are important to 
include in your backup plan. In addition, both backup methods require that a baseline backup of all 
selected files be performed before the periodic incremental or differential backups. You will also notice 
that we schedule the baseline backup job to occur on a periodic basis. This helps to minimize the size of 
the backup images and in some cases, the time to restore your files when necessary.  

Both plans use the same frequency for each type of backup job. The baseline backup will be run 
monthly and the incremental or differential backups will run daily. Again, you can modify the job 
schedule to meet your individual backup requirements. 

ª NTI’s Incremental Backup Plan: 

1. Create and save a baseline backup job of all selected files. Name it baseline.bjf and save it 
using the Save command from the Job Menu. (See “Creating a Backup Job” on Page 15 
of this guide for detailed instructions.)  

2. Run this backup job to create the required baseline backup of the selected files. (See 
“Creating a Backup Job” on Page 15 of this guide for detailed instructions.) 

3. Schedule the baseline backup job to run monthly, starting one month from now, at 
midnight. (See “Using the Scheduler” on Page 27 of this guide for detailed instructions.) 

4. Open the baseline job file (.bjf). Change the backup type to incremental from the Type 
tab of the backup options dialog. Save this job as daily.bjf using the Save As command on 
the Job Menu. (See “Creating a Backup Job” on Page 15 and “Backup Options” on Page 
37 of this guide for detailed instructions.) 

5. Schedule the incremental backup job daily.bjf to run daily, starting one day from now, at 
2:00 AM. (See “Using the Scheduler” on Page 27 of this guide for detailed instructions.) 

Note: 
³ The possibility exists that both backup jobs will run on one morning of every 

month. The baseline job is scheduled to run first and will backup all selected files on 
that date. The daily job runs second but will have very few, if any, files to backup 
and so it executes and exits quickly. 
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ª NTI’s Differential Backup Plan 

1. Create and save a baseline backup job of all selected files. Name it baseline.bjf and save it 
using the Save command from the Job Menu. (See “Creating a Backup Job” on Page 15 
of this guide for detailed instructions.)  

2. Run this backup job to create the required baseline backup of the selected files. (See 
“Creating a Backup Job” on Page 15 of this guide for detailed instructions.) 

3. Schedule the baseline backup job to run monthly, starting one month from now, at 
midnight. (See “Using the Scheduler” on Page 27 of this guide for detailed instructions.) 

4. Open the baseline job file (.bjf). Change the backup type to differential from the Type 
tab of the backup options dialog. Save this job as daily.bjf using the Save As command on 
the Job Menu. (See “Creating a Backup Job” on Page 15 and “Backup Options” on Page 
37 of this guide for detailed instructions.) 

5. Schedule the differential backup job daily.bjf to run daily, starting one day from now, at 
2:00 AM. (See “Using the Scheduler” on Page 27 of this guide for detailed instructions.) 

Note: 
³ The possibility exists that both backup jobs will run on one morning of every 

month. The baseline job is scheduled to run first and will backup all selected files on 
that date. The daily job runs second but will have very few, if any, files to backup 
and so it executes and exits quickly. 

Recommendation #6 – Make it Happen! 
Our final words of advice — Make it happen! Regardless of your backup needs, you’ll find Backup 
NOW! and DriveBackup! are invaluable tools to do just that. Make it happen!  

The rest is up to you! 

Disk Cloning for System Roll-Out or Upgrade? Yes You Can! 
What do you do when you want to rollout or update many workstations? Use DriveBackup! of course! 
Once you have a Master PC configuration (you could have more than one PC configurations) simply 
create an Emergency Recovery Disc for each configuration and use them to create clones of that 
configuration(s) on the remaining machines. Additionally, you can deploy each machine with a copy of 
the original Emergency Recovery Disc and your employees or support personnel can always reset any 
computer to its original configuration in a matter of minutes. 

Note: 

0 In most cases you will be required to have special or specific licensing for all products 
included on machines deployed in this manner. It is your responsibility to ensure that all 
products are legally licensed, including NTI DriveBackup!™. Contact NTI for additional 
information and site-licensing options. 
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74     Backup NOW! Command Reference      



B A C K U P  N O W !  C O M M A N D  R E F E R E N C E  

  

Backup NOW! Menus 
All NTI Backup NOW! menus can be invoked by a single left-button click of a mouse on the menu 
title. Menu items are aligned on the left, with keystroke shortcuts (if applicable) displayed on the 
corresponding right side. The underlined character of a menu item, if pressed (through the keyboard), 
will have the same effect as if the menu item were selected with the mouse. 

Job Menu 

 
New 
Creates a new backup job file. 

Open… 
Opens an existing backup job file. 

Save  
Saves the current backup job file (.bjf) on your computer. 

Save As… 
Saves the current backup job file (.bjf) with a specific name or path. 

Options 

 
Backup Options… 
Allows you to set the backup options for this backup operation. 

Restore Options… 
Allows you to set the restore options for this restore operation. 

Recent File  
Displays the most recently used image files. 

Exit  
Exits the Backup NOW! program. 
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Edit Menu 

 
Select 
Checks all the check boxes of the highlighted item. 

Deselect 
Unchecks all the check boxes of the highlighted item. 

Find Files…  
Brings up the Find Files dialog box, which will let you search for a file within the current backup 
volume to restore. (This option is available only in Restore mode.)  

View Menu 

 
Toolbar 
Hides or displays the main toolbar. When checked, the toolbar is displayed below the Backup NOW! 
menu bar. 

Status Bar 
Hides or views the Status Bar. When checked the status bar is displayed on the bottom of the Backup 
NOW! program window. 

Backup 
Switches Backup NOW! in to backup mode. 

Restore 
Switches Backup NOW! in to restore mode. 

Compare 
Switches Backup NOW! in to compare mode. 

Refresh 
Refreshes the current view. 
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Tools Menu 

 
Recovery Diskette & CD… 
Launches DriveBackup! (if installed). Creates a recovery diskette and/or CD for emergency rescue. 

Compare Files… 
Compares the contents of directories. 

Erase CD-RW Disc 
Erases the contents of a CD-RW disc. 

Disc Info & Tools… 
Displays various information about the media in the selected drive. 

CD Drive Properties… 
Displays the capabilities of any CD/DVD writer installed on your system. 

View Reports 

 
View Backup Reports… 
Allows you to view all backup job status reports created by Backup NOW! 

View Restore Reports… 
Allows you to view all restore job status reports created by Backup NOW! 

Live Update… 
Updates the Backup NOW! supported drive database (You must be online to use this feature). 
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Help Menu 

 
Help Topics 
Displays the Backup NOW! help system. 

Register my NTI software 
Links you to our online registration page @ www.ntius.com/register.cfm. 

NTI Home Page 
Links you to our home page @ www.ntius.com. 

Backup NOW! Home Page 
Links you to the Backup NOW! home page @ www.ntibackupnow.com. 

Frequently Asked Questions on the web 
Links you to our FAQ page @ www.ntius.com/faqs.htm. 

Software Update Download Page 
Links you to our software download page @ www.ntius.com/download.htm. 

Technical Support Page 
Links you to our technical support page @ www.ntius.com/support.htm. 

About Backup NOW!… 
Displays version and program information about Backup NOW!. 
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Toolbar 
This section describes the Toolbar in Backup NOW!. 

T O O L B A R   

 
Toolbar buttons are used as shorthand for menu commands. Each toolbar button represents a 
frequently used command. The display of these buttons is context-sensitive in that only buttons relevant 
to the current context are shown and enabled. 

The following is a run-down of the Toolbar buttons and their respective menu commands. 

Button Icon Button Name Menu Command 

 Backup View Menu:   Backup 

 Restore View Menu:   Restore 

 Compare View Menu:   Compare 

 New File Menu:   New 

 Open File Menu:   Open... 

 Save File Menu:   Save 

 Back None. 

 Forward None. 

 Up One Level None. 

 Info… Help Menu:   About Backup NOW!… 
 

Hiding the Toolbar 

ª To Hide the Toolbar:  

1. Click the Toolbar item from the View Menu. You should no longer see a small check 
mark to the left of the Toolbar item and the Toolbar should now be invisible. 

Viewing the Toolbar 

ª To Display the Toolbar:  

1. Click the Toolbar item from the View Menu. You should see a small check mark to the 
left of the Toolbar item and the Toolbar should now be displayed at the top of the main 
program window. 
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Status Bar 
 

 
Hiding the Status Bar 

ª To Hide the Status Bar: 

1. Click the Status Bar item from the View Menu. You should no longer see a small check 
mark to the left of the Status Bar item and the Status Bar should now be invisible. 

Viewing the Status Bar 

ª To Display the Status Bar: 

1. Click the Status Bar item from the View Menu. You should see a small check mark to the 
left of the Status Bar item and the Status Bar should now be displayed at the bottom of 
the main program window. 
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Glossary 
Baseline Backup 

A baseline or all files backup is a full file level backup of the selected data. It serves as a reference point 
for both incremental and differential backups. They can be scheduled periodically to reduce the number 
of restorations required for incremental backups or the space requirements of differential backups. 
Differential Backup 

Differential backups record all changes made since the last baseline backup. Any files that have been 
added or modified since the last baseline backup are included in a differential backup. This results in an 
increased space requirement for the resulting backup file. Restoring from a differential backup requires 
only that you restore the baseline backup file and then the latest differential backup. 
Drive Image Backup 

Drive Image backups are called that because they are exact duplicates of a physical disk drive on your 
machine. Unlike file level backups, drive images bypass the file system and communicate directly with 
the physical disk drive. Drive image backups cannot be scheduled using Backup NOW! Scheduler. They 
can be written to either a CD-R/CD-RW disc or another supported storage device. The best way to 
think of them is as clones. All data is replicated exactly as it exists on the drive being backed up. 
Drive Spanning  

The ability to continue a backup or restore operation over multiple CD/DVD drives. Drive Spanning 
can let you backup to multiple drives before asking for additional media. This can be helpful in cases 
where a larger amount of data must be backed up using scheduled, unattended, backups. 
Emergency Recovery Disc 

A Emergency Recovery Disc is a bootable CD/DVD with containing an image of your system 
partition. It is used to recover your system partition and let you boot your computer into Windows.  

File Level Backup 

File level backups are called that because they backup and restore your data by communication with 
your computer’s file system. All reading and writing of data is passed over to the file system. File level 
backups can be saved and scheduled to run at a preset time. Any data that your files system has access 
to, such as local or network drives can be backed up or restored through File Level backups. 
Incremental Backup 

Incremental backups record all changes made since the last backup. Only files that have been added or 
modified since the last backup are included in an incremental backup. This results in a reduced space 
requirement as saves media. Restoring from an incremental backup requires that you restore the 
baseline backup file and then each subsequent incremental backup, in order, until you get to the desired 
target date. 
Media Spanning  

The ability to continue a backup or restore operation over multiple CDs. Media Spanning removes the 
limitations that the media capacity would otherwise place on the size of a single backup or restore 
operation. 
Startup Diskette 

A Startup Diskette is a bootable diskette that is created by the Windows operating system. It can be 
used to boot your system to DOS and run some basic troubleshooting tools when you cannot boot 
from your system hard drive. 
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